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1 Introduction

The Nordic Thingy:91™ is a battery-operated prototyping platform for cellular IoT, certified for global
operation. It is ideal for rapid development of prototypes for cellular IoT systems and is especially suited
for asset tracking applications and environmental monitoring.

Nordic Thingy:91 includes sensors that gather data about its own movements and the surrounding
environment. Temperature, humidity, air quality, air pressure, color, and light data can easily be extracted
for local or remote analysis. For input, the Nordic Thingy:91 offers a user-programmable button. Visual
output is achieved with RGB indicator LEDs, while a buzzer can provide audible output. The standard
application firmware on Nordic Thingy:91 extracts the data from the different sensors and relays it
securely to the nRF Cloud, where it is displayed in a user-friendly interface.

The firmware supports concurrent operation with LTE Link Monitor, a tool providing an AT command
interface, enabling link and network testing. LTE Link Monitor is an application, which is implemented as
part of the nRF Connect for Desktop application. The firmware has been developed using the nRF Connect
Software Development Kit (SDK). It is open source and can be leveraged and modified to suit your specific
needs. The firmware can be updated and debugged by using an external programmer/debug probe, for
example nRF9160 Development Kit (DK) or J-Link device supporting Arm Cortex-M33.

Nordic Thingy:91 integrates the nRF9160 System in Package (SiP)1, supporting LTE-M, NB-IoT and Global
Positioning System (GPS), and the nRF52840 System on Chip (SoC), supporting Bluetooth® Low Energy and
Near Field Communication (NFC) passive tag.

Note:  LTE-M or LTE NB-IoT can operate simultaneously with Bluetooth LE.

Source code for firmware, hardware layout, and schematics are all available on our web site
www.nordicsemi.com.

Nordic Thingy:91 has an antenna supporting GPS, LTE-M, and NB-IoT that enables it to support a global
range of LTE bands. It has two antennas connected to the nRF52840: a 2.4 GHz antenna for Bluetooth LE
and an NFC passive tag antenna. To connect to cellular network out of the box, Nordic Thingy:91 has a
nano/4FF SIM card slot and is bundled with a SIM card from iBasis that comes preloaded with 10 MB. See
iBasis IoT network coverage for information on the network coverage in different regions.

NFC in Nordic Thingy:91 operates as a passive tag (e.g. it does not feature a reader function). Nordic
Thingy:91 may use this tag function for the Out of Band pairing feature as described in the Bluetooth Core
Specification.

A rechargeable Li-Po battery is also part of this prototyping platform giving a smooth transition into
prototype field-testing, 1400 mAh for Nordic Thingy:91 v1.0.0, and 1350 mAh for Nordic Thingy:91 v1.4.0.

Key features of Nordic Thingy:91
• 700-960 MHz + 1710-2200 MHz LTE band support2. The following bands, based on geographic regions,

are used:

• USA – 2, 4, 12, and 13
• EU – 3, 8, 20, and 28

• Certifications: CE, FCC

1 The nRF9160 SiP is certified for USA bands 2, 4, 5, 12, 13, 14, 17, 25, 26, and 66. However, Nordic
Thingy:91 operates and is only certified for USA bands 2, 4, 12, and 13. The Nordic Thingy:91
firmware is written and documented to only use this subset of USA bands.

2 The application currently enables the following frequency bands: 2, 3, 4, 8, 12, 13, 20, and 28.
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• LTE-M/NB-IoT/GPS, Bluetooth LE and NFC passive tag antennas
• Nano/4FF Subscriber Identity Module (SIM) card slot
• MFF2 M2M Form Factor eUICC (Nordic Thingy:91 v1.4.0 only)
• User-programmable button and RGB LEDs
• Environmental sensor for temperature, humidity, air quality, and air pressure
• Color and light sensor
• Low-power and high-G accelerometer
• Buzzer
• 4 x N-MOS transistor for external DC motors or LEDs
• 16 kbit I2C serial EEPROM (Nordic Thingy:91 v1.4.0 only)
• Rechargeable Li-Po battery with:

• 1400 mAh capacity for Nordic Thingy:91 v1.0.0
• 1350 mAh capacity for Nordic Thingy:91 v1.4.0

• Charging through Universal Serial Bus (USB)
• PC connection through USB
• Normal operating temperature range: 5oC ~ 35oC

nRF9160
• Multimode LTE-M/NB-IoT modem

• GCF certified for global operation
• 23 dBm output power
• GPS
• Power saving features: DRX, eDRX, PSM
• Coverage enhancement modes
• Single pin 50 Ω antenna interface
• Universal Integrated Circuit Card (UICC) interface

• Application processor

• 64 MHz Arm® Cortex®-M33 CPU
• Arm TrustZone® for trusted execution
• Arm CryptoCell 310 for application layer security
• 1 MB flash and 256 kB RAM
• 4 x SPI/UART/TWI, PDM, I2S, PWM, ADC

nRF52840 WLCSP
• Bluetooth LE and NFC passive tag support
• 64 MHz Arm Cortex-M4F CPU
• 1 MB flash and 256 kB RAM
• USB
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The battery in this product cannot be easily replaced by users themselves. Batteries should be removed
only by qualified professionals due to safety concerns.
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2 Kit content

The Nordic Thingy:91 kit consists of hardware and access to software components, hardware design files,
applications, and documentation.

Figure 1: Nordic Thingy:91 hardware content

The Nordic Thingy:91 kit contains the following:

• Nordic Thingy:91 device with a rubber enclosure serving as a protective cover
• An eSIM (SIM card) from iBASIS supported by the nano/4FF SIM card slot of Nordic Thingy:91
• An information leaflet

WARNING - Power adapter is not included in the kit.3

2.1 Downloadable content
The Nordic Thingy:91 prototyping platform includes firmware source code, documentation, hardware
schematics, and layout files.

Firmware
• Application firmware for Nordic Thingy:91

3 Power supply adapter is not included in the safety certification test report, see separate test report
according to IEC 62368. The power supply adapter you will use shall meet PS1 requirements.
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Kit content

• Asset Tracker v2 firmware for nRF9160
• Connectivity bridge for nRF52840

• nRF9160 modem firmware
• nRF Connect SDK

PC tools
• nRF Connect LTE Link Monitor
• Segger Embedded Studio
• nRF Connect Programmer

Web applications
• nRF Cloud (nrfcloud.com)

Hardware files
The hardware files can be downloaded from the Nordic Thingy:91 product page.

The zip file and its subdirectories contain the hardware design files for the Nordic Thingy:91. The hardware
files for the circuit board are available in the following folder in the hardware files zip package:

\Thingy91 - Hardware files x_x_x\PCA20035-Thingy91 Board x_x_x

In this folder, you can find the following hardware design files:

• Altium Designer files
• Schematics and PCB layout files in PDF format
• Production files:

• Bill of materials
• Drill files
• Assembly drawings
• Gerber files
• Pick-and-place files
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3 Hardware description

This chapter focuses on the hardware components of Nordic Thingy:91 with detailed descriptions of the
various hardware blocks that are present on the device.

The sensors available in Nordic Thingy:91 are not calibrated in production. Nordic Semiconductor does
not specify the accuracy of measurements. Users who want to reuse parts of this design to create
measurement devices should conform to documentation of the specific sensors.

3.1 Block diagram
The block diagram represents interactions between hardware components on Nordic Thingy:91.

USB Power switch

nRF9160

GPS LNA

Power switchBattery

SWD selectDebug in

Current 
measurement

Accelerometers

Environmental 
sensor

SIM select

NMOS 
transistors

LEDs

RF switches/
matching 
network

LED driver

Color sensor

Buzzer

Buzzer driver

nRF52840

Current 
measurement

Spare GPIO 
connector

Button

Matching 
network

Button

NFC passive tag 
antenna

RF

1.8 V3.3 V

Antenna

Antenna

EEPROM

MFF2 SIM

SIM card

PMIC

Figure 2: Nordic Thingy:91 hardware block diagram
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3.2 Hardware figures
The hardware figures show elements on both sides of the Nordic Thingy:91 PCB.

Figure 3: Nordic Thingy:91 PCB, top

Figure 4: Nordic Thingy:91 PCB, bottom

3.3 nRF9160
The nRF9160 is the main device of Nordic Thingy:91. It is a compact, highly integrated SiP that makes use
of the latest low-power LTE technology. It has advanced processing capabilities and security features. It
also has the accessibility and flexibility to be used with a wide range of single-device low-power cellular
IoT applications.

For more information, see nRF9160 Product Specification.
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Hardware description

Figure 5: nRF9160 schematic

3.3.1 Antenna tuning
To improve antenna efficiency, Nordic Thingy:91 has dynamic antenna tuning.

Different tuning components are used for different frequencies. This is achieved by using tuning
components between two SP8T RF switches. The switches are automatically controlled by the nRF9160
LTE modem and set to the correct state based on the frequency of operation. Six paths are used for LTE
frequency, and one path is used for GPS frequency.

RF_SW3 RF_SW2 RF_SW1 State Band Frequency

0 0 0 RF2 - RFC Not used Not used

0 0 1 RF7 - RFC 13U/D, 28D 746 MHz - 803 MHz

0 1 0 RF5 - RFC 12U/D, 17U/D, 28U

1U/D, 2U/D, 3U/D, 4U/D,
25U/D

698 MHz - 748 MHz

1710 MHz - 2200 MHz

0 1 1 RF3 - RFC 5D, 20U, 26D 824 MHz - 894 MHz

1 0 0 RF1 - RFC 8U/D 880 MHz - 960 MHz

1 0 1 RF8 - RFC 5U, 20D, 26U 791 MHz - 849 MHz

1 1 0 RF6 - RFC Not used Not used

1 1 1 RF4 - RFC GPS 1574 MHz - 1577 MHz

Table 1: Antenna tuning bands
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Figure 6: Antenna tuning circuitry schematic

3.3.2 Antenna performance
Performance of the Nordic Thingy:91 antenna has been measured in an environment as close to an actual
use case as possible, where Nordic Thingy:91 typically is standalone and battery operated.

The table below shows basic average performance data of the antenna.

Technical
features

698–748
MHz

746–803
MHz

791–849
MHz

824–894
MHz

880–960
MHz

1575 MHz 1710–2220
MHz

Average
efficiency

9.2% 12.6% 15.8% 18.5% 11.1% 39.8% 47.4%

VSWR
(voltage
standing
wave ratio)

< 3:1

Table 2: Technical overview of the antenna

The figure below shows the antenna efficiency curves for each individual tuning path for LTE frequencies.

Figure 7: Individual antenna efficiency plot for LTE bands

The different tuning paths used for the LTE frequencies give best antenna efficiency in one part of the
frequency band. By defining the frequency switching in a way that ensures the next range taking over once
the performance of the current range starts declining, the overall antenna efficiency can be improved.
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Figure 8: Overall antenna efficiency plot for LTE bands

Figure below shows the antenna efficiency for the GPS band and the neighboring frequencies.

Figure 9: Antenna efficiency plot for GPS band

3.3.3 RF measurements
The LTE signals are propagated through a coaxial connector. This makes it possible to perform conducted
measurements or attach external antennas.

By default, when no cable is attached, the RF signal is routed to the onboard antenna. When connecting
the adapter, the internal switch in the SWF connector will disconnect the onboard antenna and connect
the RF signal from the nRF9160 to the adapter.
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The connector is of SWF type (Murata part no. MM8130-2600) with an internal switch. An adapter
is available (Murata part no. MXHS83QE3000) with a standard SMA connection on the other end for
connecting instruments. The adapter is not included in the kit. The insertion loss in the adapter cable is
approximately 0.5–1 dB.

Figure 10: Connecting a spectrum analyzer

3.3.4 GPS
The nRF9160 SiP has a dedicated GPS port to support global navigation, and the same antenna is used for
both LTE and GPS. The GPS signal is RX only, and there is a low-noise amplifier (Low-Noise Amplifier (LNA))
that amplifies the signal before it is fed to the GPS RF port on the nRF9160.

Note:  GPS signals do not usually penetrate ceilings or other structures. For best GPS performance,
Nordic Thingy:91 should be used outside in an open space, far from sources of interference and
other structures that may block the signals.

3.3.4.1 GPS in Nordic Thingy:91 v1.0.0
For Nordic Thingy:91 v1.0.0, the GPS signals are propagated through a coaxial connector located between
the antenna and the LNA.

The coaxial connector makes it possible to attach external antennas. The connector is of SWF type (Murata
part no. MM8130-2600) with an internal switch. An adapter is available (Murata part no. MXHS83QE3000)
with a standard SMA connection on the other end for connecting instruments. The adapter is not included
in the kit. The insertion loss in the adapter cable is approximately 0.5–1 dB.
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Figure 11: External GPS antenna connector on Nordic Thingy:91 v1.0.0

The LNA enable signal is controlled by the logic circuitry. It is enabled only when the antenna tuning
circuitry is set to operate at the GPS frequency band. The LNA makes the GPS receiver more sensitive to
GPS signals and less sensitive to interference from other sources nearby.

Figure 12: GPS circuit schematic for Nordic Thingy:91 v1.0.0

3.3.4.2 GPS in Nordic Thingy:91 v1.4.0
With Nordic Thingy:91 v1.4.0, the connector type changed to a Hirose U.FL compatible connector (I-PEX
MHF).

An external active GPS antenna can be connected to connector J2.
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Figure 13: External GPS antenna connector on Nordic Thingy:91 v1.4.0

When an external antenna is used, the on-board LNA should be disabled. The LNA enable signal is
controlled by the COEX0 pin of the nRF9160, and its function is set by the AT%XCOEX0 AT command. The
LNA makes the GPS receiver more sensitive to GPS signals and less sensitive to interference from other
sources nearby.

Figure 14: GPS circuit schematic for Nordic Thingy:91 v1.4.0

To disable the on-board LNA, the following needs to be done in the firmware:

1. In the file nrf/boards/arm/thingy91_nrf9160/board_nonsecure.c, change the line
#define AT_CMD_COEX0 "AT%XCOEX0=1,1,1570,1580" to #define AT_CMD_COEX0
"AT%XCOEX0".

2. Save the file, and rebuild the firmware as described in Working with Thingy:91 nRF Connect SDK
documentation.

3.3.5 SIM card
Nordic Thingy:91 is equipped with a nano-SIM (4FF) card slot. As of Nordic Thingy:91 v1.4.0 it is also
equipped with a footprint for an MFF2 SIM card.
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Figure 15: SIM card schematic for Nordic Thingy:91 v1.0.0

Figure 16: SIM card schematic for Nordic Thingy:91 v1.4.0

Switching between the two types is controlled by the presence of a 4FF SIM card.

3.4 nRF52840
For USB, Bluetooth, and NFC passive tag connectivity, Nordic Thingy:91 uses a nRF52840 SoC. It is a
powerful, highly flexible, ultra-low power SoC that incorporates a Bluetooth Low Energy radio and a 32-bit
Arm Cortex-M4F CPU.

For more information on the SoC, see nRF52840 Product Specification.
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Figure 17: nRF52840 schematic

3.4.1 NFC passive tag
Nordic Thingy:91 supports an NFC passive tag. NFC-A listen mode operation is supported on the
nRF52840.

The NFC passive tag antenna input is available on connector J5.

Figure 18: NFC passive tag antenna connector

The NFC passive tag uses two pins, F1 (NFC1) and E2 (NFC2), to connect the antenna. These pins are
shared with GPIOs (P0.09 and P0.10), and the PROTECT field in the NFCPINS register in UICR defines
the usage of these pins and their protection level against abnormal voltages. The content of the NFCPINS
register is reloaded at every reset.

Note:  The NFC passive tag pins are enabled by default.

The NFC passive tag can be disabled and the GPIOs enabled by defining the
CONFIG_NFCT_PINS_AS_GPIOS variable in the project settings. The way of doing this depends on the
Integrated Development Environment (IDE) or toolchain in use.

• When using SEGGER Embedded Studio, go to Project > Edit Options > Code > Preprocessor >
Preprocessor Definitions and add the CONFIG_NFCT_PINS_AS_GPIOS variable.
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• When using Keil, go to Project > Options for Target > C/C++ > Preprocessor Symbols > Define and add
the CONFIG_NFCT_PINS_AS_GPIOS variable.

3.4.2 USB
The Nordic Thingy:91 USB connector is connected to the USB interface of the nRF52840 SoC. This enables
PC communication and battery charging.

3.5 Pin maps
The pin assignments for the nRF9160 SiP and nRF52840 SoC are listed in the pin map tables.

I/O Label Description

P0.00 SENSE_LED_RED Red color of the color sensor support LED

P0.01 SENSE_LED_GREEN Green color of the color sensor support LED

P0.02 SENSE_LED_BLUE Blue color of the color sensor support LED

P0.03 SCK SPI clock line

P0.04 MOSI SPI master output, slave input data line

P0.05 MISO SPI master input, slave output data line

P0.06 ADXL372_INT1 High-G accelerometer interrupt line

P0.07 ADXL372_CS High-G accelerometer chip select line

P0.08 ADXL362_CS Low-power accelerometer chip select line

P0.09 ADXL362_INT1 Low-power accelerometer interrupt line

P0.10 nRF52_RESET (Default
Nordic Thingy:91 v1.4.0)

ADXL362_INT2
(Optional)

ADXL372_INT2
(Optional)

On Nordic Thingy:91 v1.4.0, P0.10 is connected to
the reset line of the nRF52840 device by default.
Optionally, P0.10 can be connected to the interrupt
line 2 of the accelerometers, selectable by solder
bridge.

On Nordic Thingy:91 v1.0.0, P0.10 is not connected
by default. Optionally, P0.10 can be connected
to the interrupt line 2 of the accelerometers,
selectable by solder bridge.

P0.11 SDA I2C data line

P0.12 SCL I2C clock line

P0.13 N-MOS_1 Gate of N-MOS transistor externally available

P0.14 N-MOS_2 Gate of N-MOS transistor externally available

P0.15 N-MOS_3 Gate of N-MOS transistor externally available

P0.16 N-MOS_4 Gate of N-MOS transistor externally available

P0.17 ADP_INT PMIC interrupt line

P0.18 MCU_IF0 nRF52840 interface

P0.19 MCU_IF1 nRF52840 interface
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I/O Label Description

P0.20 MCU_IF2 nRF52840 interface

P0.21 MCU_IF3 nRF52840 interface

P0.22 MCU_IF4 nRF52840 interface

P0.23 MCU_IF5 nRF52840 interface

P0.24 MCU_IF6 nRF52840 interface

P0.25 MCU_IF7 nRF52840 interface

P0.26 BUTTON Button input

P0.27 BH_INT Color sensor interrupt line

P0.28 BUZZER Buzzer PWM signal

P0.29 LIGHTWELL_RED Red color of the lightwell LEDs

P0.30 LIGHTWELL_GREEN Green color of the lightwell LEDs

P0.31 LIGHTWELL_BLUE Blue color of the lightwell LEDs

Table 3: nRF9160 pin map
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I/O Label Description

P0.00 XL1 Low frequency crystal

P0.01 XL2 Low frequency crystal

P0.02 N.A. Not used

P0.03 SPARE7 Analog/digital GPIO externally available

P0.04 N.A. Not used

P0.05 SPARE2 Analog/digital GPIO externally available

P0.06 SPARE1 Digital GPIO externally available

P0.07 N.A. Not used

P0.08 N.A. Not used

P0.09 NFC1 NFC passive tag antenna

P0.10 NFC2 NFC passive tag antenna

P0.11 MCU_IF0 nRF9160 interface

P0.12 N.A. Not used

P0.13 N.A. Not used

P0.14 IF_SWD_IO nRF9160 SWD interface data line

P0.15 MCU_IF1 nRF9160 interface

P0.16 N.A. Not used

P0.17 IF_SWD_CTRL nRF9160 SWD interface control

P0.18 RESET nRF52840 reset line

P0.19 MCU_IF6 nRF9160 interface

P0.20 MCU_IF2 nRF9160 interface

P0.21 MCU_IF3 nRF9160 interface

P0.22 MCU_IF7 nRF9160 interface

P0.23 N.A. Not used

P0.24 N.A. Not used

P0.25 MCU_IF5 nRF9160 interface

P0.26 SPARE3 Digital GPIO externally available

P0.27 SPARE4 Digital GPIO externally available

P0.28 SPARE5 Digital GPIO externally available

P0.29 N.A. Not used

P0.30 SPARE6 Analog/digital GPIO externally available

P0.31 N.A. Not used

P1.00 MCU_IF4 nRF9160 interface

P1.01 COEX2 nRF9160 COEX interface
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I/O Label Description

P1.02 N.A. Not used

P1.03 N.A. Not used

P1.04 COEX1 nRF9160 COEX interface

P1.05 IF_SWK_CLK nRF9160 SWD interface clock line

P1.06 N.A. Not used

P1.07 COEX0 nRF9160 COEX interface

P1.08 SDA I2C data line

P1.09 SCL I2C clock line

P1.10 N.A. Not used

P1.11 SPARE8 Digital GPIO externally available

P1.12 N.A. Not used

P1.13 BOOT Boot button

P1.14 N.A. Not used

P1.15 N.A. Not used

Table 4: nRF52840 pin map

3.6 Motion sensors
Nordic Thingy:91 includes a low-power accelerometer and a high-G accelerometer.
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Figure 19: Low-power and high-G accelerometers schematic

When Nordic Thingy:91 is in low-power sleep mode, any user interaction will be detected by the low-
power accelerometer. The accelerometer has an SPI interface and it can detect motion on three axes. By
default, the INT2 line of the accelerometer is not connected to nRF9160. If you want to use the INT2 line,
solder SB6.

For detecting shocks, Nordic Thingy:91 uses a high-G accelerometer. The accelerometer has an SPI
interface, and it can detect motion on three axes. By default, the INT2 line of the accelerometer is not
connected to nRF9160. If you want to use the INT2 line, solder SB5.

Figure 20: Low-power accelerometer and high-G accelerometer interrupt line 2 selection
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Note:  On Nordic Thingy:91 v1.4.0, by default, P0.10 is connected to the nRF52_RESET line
through SB14. The nRF52840 P0.18 can be configured as a regular GPIO instead of RESET or SB14
should be cut to avoid having the accelerometer reset nRF52840.

3.7 Environment sensors
To monitor its surroundings, Nordic Thingy:91 has a multi-sensor chip that contains several sensors for
detecting different environmental properties and a separate color and light sensor.

The multi-sensor chip contains sensors for temperature, humidity, air quality, and air pressure.

Figure 21: Environment sensor schematic

The color sensor onboard Nordic Thingy:91 senses red, green, blue, and infrared light. The sensor faces
towards the blue transparent bottom case with light pipes guiding the light towards the sensor. To
measure the color on a surface, the color sensor is accompanied with an RGB LED that can illuminate
the surface enabling the color sensor to read the color of the reflected light. The color sensor is accessed
through I2C (slave address 0x38).

Figure 22: Color sensor schematic

3.8 EEPROM
To store important information off-chip, Nordic Thingy:91 is equipped with a 16-Kbit I2C serial EEPROM
(electrically erasable programmable read-only memory) as of version 1.4.0. The I2C address is 0x50.

Information stored in region 0x0600 - 0x07FF is written during the production of Nordic Thingy:91. This is
critical for the correct operation and should not be changed.

Figure 23: EEPROM schematic
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3.9 Buzzer
For audio output, Nordic Thingy:91 has a magnetic buzzer. The buzzer is driven by a transistor using a
PWM input.

Figure 24: Buzzer schematic

3.10 LEDs and buttons
Nordic Thingy:91 user interface consists of RGB LEDs and two buttons.

3.10.1 RGB LED
Nordic Thingy:91 is equipped with three RGB LEDs.

Two of the LEDs are used to light up the light well and are controlled by the same signals using transistors
as switches. The third LED is located near the color sensor and is used as auxiliary light for color
measurements.

Figure 25: LED schematic

3.10.2 Buttons
Nordic Thingy:91 has two buttons.

The main button, located underneath the Nordic Semiconductor logo, is termed as the SW3 button and it
is used for user input. It is connected to the nRF9160 SiP. The second button, termed as SW4, is connected
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to the nRF52840 SoC. It is accessible only when the rubber cover on the device is removed. Refer the
image Figure 3 to locate the buttons.

Either of the two buttons, SW3 or SW4, can be used to activate the serial recovery mode of Nordic
Thingy:91 to update the nRF9160 SiP or the nRF52840 SoC respectively.

For more information, see Updating firmware on Nordic Thingy:91 through USB.

3.11 Power supply
The main power source is a rechargeable lithium polymer (Li-Po) battery. The battery has a nominal
capacity of 1400 mAh and can be recharged through USB.

Nordic Thingy:91 has a power switch that physically disconnects the battery and the USB power from the
rest of the circuits. This switch must be on for Nordic Thingy:91 to work and charge the battery. When the
power switch is in the OFF position, it activates a circuit that drains the 1.8 V power domain.

Figure 26: Schematics for battery connector, and the power switch

3.11.1 PMIC
Nordic Thingy:91 uses a power management IC (PMIC) as internal power management. The PMIC includes
a battery charger, a fuel gauge and two regulator outputs.

The PMIC has three voltage domain outputs that are used on Nordic Thingy:91:

• VSYS used for the nRF9160 SiP
• One 1.8 V output used as GPIO voltage
• One 3.3 V output used for analog circuitry

The 1.8 V domain supplies the nRF52840, the accelerometers, the environment sensors, and the GPIOs of
the nRF9160. This domain must always be on for Nordic Thingy:91 to work.

The 3.3 V domain supplies the LEDs, the color sensor, the buzzer, the RF switches and the GPS LNA. This
power domain can be powered down to save power when Nordic Thingy:91 is in sleep mode.
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Figure 27: PMIC schematic

3.11.2 Current measurement
It is possible to measure the current flowing to nRF9160 and nRF52840 by cutting the short on SB3
(nRF9160) and/or SB4 (nRF52840) and placing an ampere meter between the terminals of P1 (nRF9160)
and terminals of P2 (nRF52840).

Figure 28: Measuring current to the nRF9160
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Figure 29: Measuring current to the nRF52840

Figure 30: Current measurement schematic

3.12 Programming and debugging interface
Nordic Thingy:91 is equipped with one programming and debugging interface connector (P8) that is
shared between the nRF9160 and nRF52840.

The device to be programmed is selected by the SWD SELECT switch (SW2). The selection of device can
also be controlled by connecting TP28 to 1.8 V or ground.

Figure 31: SWD SELECT switch
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The SWD interface of the nRF9160 can also be connected to the nRF52840. The enabling of this
connection is controlled by the nRF52840.

Figure 32: SWD interface and control schematic

3.13 Interface
To enable the user to connect external hardware, Nordic Thingy:91 routes some of the GPIOs to
connectors or test points and transistors to drive higher currents.

3.13.1 N-MOS transistors
Nordic Thingy:91 is equipped with four N-MOS transistors that can be used to drive small DC motors
or LEDs. The drain and source of the transistors are available on external connectors and the gate is
connected directly to the nRF9160.

Figure 33: Schematics for the N-MOS transistors

3.13.2 Connectors
In addition to the N-MOS drain and source on P7, power domains and extra GPIOs can be found on
connectors P3-P6.

For more information, see Connector pinouts on page 32.
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Figure 34: Nordic Thingy:91 external connectors

3.13.2.1 Connector pinouts

Pin Signal Description

1 GND Ground

2 VLi-Ion Battery voltage

Table 5: Pinout of connector P3

Pin Signal Description

1 GND Ground

2 1V8 Regulated 1.8 V domain

Table 6: Pinout of connector P4

Pin Signal Description

1 GND Ground

2 3V3 Regulated 3.3 V domain

Table 7: Pinout of connector P5

Pin Signal Description

1 SPARE1 GPIO of the nRF52840

2 SPARE2 GPIO of the nRF52840

3 SPARE3 GPIO of the nRF52840

4 SPARE4 GPIO of the nRF52840

5 SPARE5 GPIO of the nRF52840

6 SPARE6 GPIO of the nRF52840

Table 8: Pinout of connector P6
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Pin Signal Description

1 1V8 Regulated 1.8 V domain

2 GND Ground

3 MOS_1_D Drain of n-channel MOSFET 1

4 MOS_1_S Source of n-channel MOSFET 1

5 MOS_2_D Drain of n-channel MOSFET 2

6 MOS_2_S Source of n-channel MOSFET 2

7 MOS_3_D Drain of n-channel MOSFET 3

8 MOS_3_S Source of n-channel MOSFET 3

9 MOS_4_D Drain of n-channel MOSFET 4

10 MOS_4_S Source of n-channel MOSFET 4

Table 9: Pinout of connector P7

3.13.3 Test points
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Test point Location Signal Description

TP1 Bottom N.A. Reserved

TP2 Bottom RF_SW1 Bit 0 of RF switch control signals

TP3 Bottom RF_SW2 Bit 1 of RF switch control signals

TP4 Bottom RF_SW3 Bit 2 of RF switch control signals

TP5 Bottom N.A. Reserved

TP6 Bottom N.A. Reserved

TP7 Bottom nRF91-P0.10 GPIO of the nRF9160

TP8 Top nRF52-P0.18/RESET GPIO/RESET of the nRF52840

TP9 Top SCL I2C clock line

TP10 Top SDA I2C data line

TP11 Top VBUS' USB voltage before power switch

TP12 Top VBUS USB voltage after power switch

TP13 Top VLi-Ion' Battery voltage before power switch

TP14 Top VLi-Ion Battery voltage after power switch

TP15 Top GND Ground

TP16 Top GND Ground

TP17 Top VSYS Internal power domain of PMIC and
default nRF9160 power supply

TP18 Top 1V8 Regulated 1.8 V domain

TP19 Top 3V3 Regulated 3.3 V domain

TP20 Bottom ADP_PGOOD1 PMIC output status indication pin 1

TP21 Bottom ADP_PGOOD2 PMIC output status indication pin 2

TP22 Bottom ADP_STP Stop the buck regulator switching of
PMIC

TP23 Bottom ADP_RESET PMIC reset output

TP24 Bottom ADP_MR PMIC manual reset input

TP25 Bottom SPARE7 GPIO of the nRF52840

TP26 Bottom SPARE8 GPIO of the nRF52840

TP27 Top SWDIO Programming interface data line

TP28 Top SWDSEL Programming interface target select

TP29 Top SWDCLK Programming interface clock line

TP30 Top D- USB data line

TP31 Top D+ USB data line

TP32 Top nRF91-P0.13/AIN0 Analog/digital GPIO of the nRF9160,
combined with N-MOS1

4418_1336 34



Hardware description

Test point Location Signal Description

TP33 Top nRF91-P0.16/AIN3 Analog/digital GPIO of the nRF9160,
combined with N-MOS4

TP34 Top SCK SPI clock line

TP35 Top MOSI SPI master output, slave input data
line

TP36 Top MISO SPI master input, slave output data
line

TP37 Top ADXL372_CS High-G accelerometer chip select line

TP38 Top ADXL362_CS Low-power accelerometer chip select
line

Table 10: Pinout of connector P3
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4 Troubleshooting

These troubleshooting instructions can help you fix issues you might encounter working with Nordic
Thingy:91.

4.1 Updating the nRF Cloud certificate
The nRF9160: Asset Tracker v2 application transmits data to nRF Cloud for visualization. Therefore, it
requires a valid up-to-date security certificate.

After you have established a connection with nRF Cloud, if the security certificate is overwritten at some
point of time, you might need to update the security certificate that is stored in Nordic Thingy:91.

Note:  Nordic Thingy:91 comes pre-provisioned with a valid nRF Cloud certificate, and the following
steps are required only if you need to update the certificate on Nordic Thingy:91.

4.1.1 Downloading the nRF Cloud certificate
You can download the nRF Cloud certificate for your Nordic Thingy:91 from nRF Cloud.

Complete the following steps to download the certificate:
1. Go to nRF Cloud (nrfcloud.com) and sign in.
2. Click the menu icon in the top-right corner and select Account.
3. In the Provision Devices page that opens up, click on the gear icon in the upper-right corner and select

Create JITP certificates to enter the following details:

Device ID
The device ID is composed of nrf- and the 15-digit International Mobile (Station) Equipment
Identity (IMEI) number that is printed on the label of your Nordic Thingy:91. For example:
nrf-123456789012345

Ownership code
The ownership code is the Personal Identification Number (PIN) or the hardware ID of your Nordic
Thingy:91. You can find it on the label of your Nordic Thingy:91. If the label contains a PIN in
addition to the IMEI number, enter this PIN.

Note:  The ownership code serves as a password and proves that you own the specific Nordic
Thingy:91. Therefore, you should not share it with anyone.

4. Click Download Certificate and save the *.cert.json file to a folder of your choice.

Note:  The certificate contains all information that is needed to connect your Nordic Thingy:91
to nRF Cloud. Therefore, you should not share the certificate with anyone.

4.1.2 Provisioning the nRF Cloud certificate
After retrieving the certificate from nRF Cloud, you must provision it to your Nordic Thingy:91.

Note:  The application firmware on the Nordic Thingy:91 must support long AT commands up
to 3 kB to provision the certificate. If you updated the application firmware as described, this
requirement is fulfilled.
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Complete the following steps to provision the certificate:
1. Open nRF Connect for Desktop and launch nRF Connect LTE Link Monitor.
2. In the Settings pane on the right, deselect the check box for Automatic requests.
3. If you have already inserted the SIM card into your Nordic Thingy:91, remove it before you continue.
4. Connect Nordic Thingy:91 to the computer with a micro-USB cable, and turn it on.

In the navigation bar, No devices available changes to Select device.
5. Click Terminal in the navigation bar to switch to the terminal view.
6. Enter AT+CFUN=4 in the AT command text field and click Send.

This AT command puts the modem to offline state.
7. Enter AT+CFUN? in the AT command text field and click Send.

This AT command returns the state of the modem.
The command should return +CFUN: 4, which indicates that the modem is in offline state. If it
returns a different value, repeat the previous step.

8. Click Certificate manager in the navigation bar to switch to the certificate manager view.
9. Click Load from JSON and select the *.cert.json file that you downloaded from nRF Cloud.

You can also drag and drop the file onto the GUI.
10.Ensure that the Security tag is set to 16842753, which is the security tag for nRF Cloud credentials.
11.Click Update certificates.

The log message "Certificate update completed" indicates that the certificate was provisioned
successfully.
If you encounter any errors, switch to the terminal view and check the output of the AT commands that
were sent to the Nordic Thingy:91 modem.

Note:  If you had connected your Nordic Thingy:91 to nRF Cloud before, you must delete the device
there after provisioning the certificate. To do so, open the entry for your device from the Devices
view, click Configure, and select Delete Device. Then, add the Nordic Thingy:91 again as described
in Getting started.
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5 Regulatory notices

The following regulatory notices apply to Nordic Thingy:91.

5.1 FCC regulatory notices

Modification statement
Nordic Semiconductor ASA has not approved any changes or modifications to this device by the user. Any
changes or modifications could void the user’s authority to operate the equipment.

Interference statement
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Wireless notice
This device complies with FCC radiation exposure limits set forth for an uncontrolled environment and
meets the FCC radio frequency (RF) Exposure Guidelines. This transmitter must not be co-located or
operating in conjunction with any other antenna or transmitter. The antenna should be installed and
operated with minimum distance of 20 cm between the radiator and your body.

FCC Class B digital device notice
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is

connected.
• Consult the dealer or an experienced radio/TV technician for help.
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Glossary
Development Kit (DK)

A development platform used for application development.

International Mobile (Station) Equipment Identity (IMEI)
A unique code consisting of 14 digits and a check digit for identifying 3GPP-based mobile devices.

GPIO
General-Purpose Input/Output

Global Positioning System (GPS)
A satellite-based radio navigation system that provides its users with accurate location and time
information over the globe.

Integrated Development Environment (IDE)
A software application that provides facilities for software development.

Low-Noise Amplifier (LNA)
In a radio receiving system, an electronic amplifier that amplifies a very low-power signal without
significantly degrading its signal-to-noise ratio.

MCUboot
A secure bootloader for 32-bit microcontroller units, which is independent of hardware and
operating system.

Near Field Communication (NFC)
A standards-based short-range wireless connectivity technology that enables two electronic devices
to establish communication by bringing them close to each other.

nRF Cloud
Nordic Semiconductor's platform for connecting IoT devices to the cloud, viewing and analyzing
device message data, prototyping ideas that use Nordic Semiconductor chips, and more. It includes a
public REST API that can be used for building IoT solutions. See nRF Cloud (nrfcloud.com).

Personal Identification Number (PIN)
An optional security feature in mobile devices used for identifying a user. PIN is a numeric code
which must be entered each time a mobile device is started.

Personal Unblocking Key (PUK)
A digit sequence required in 3GPP mobile phones to unlock a SIM that has disabled itself after an in
correct personal identification number has been entered multiple times.

Software Development Kit (SDK)
A set of tools used for developing applications for a specific device or operating system.

SEGGER Embedded Studio (SES)
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A cross-platform IDE for embedded C/C++ programming with support for Nordic Semiconductor
devices, produced by SEGGER Microcontroller.

Subscriber Identity Module (SIM)
A card used in User Equipment (UE) containing data for subscriber identification.

System in Package (SiP)
A number of integrated circuits, often from different technologies, enclosed in a single module that
performs as a system or subsystem.

System on Chip (SoC)
A microchip that integrates all the necessary electronic circuits and components of a computer or
other electronic systems on a single integrated circuit.

User Equipment (UE)
Any device used by an end-user to communicate. The UE consists of the Mobile Equipment (ME) and
the Universal Integrated Circuit Card (UICC).

Universal Integrated Circuit Card (UICC)
A new generation SIM used in UE for ensuring the integrity and security of personal data.

Universal Serial Bus (USB)
An industry standard that establishes specifications for cables and connectors and protocols for
connection, communication, and power supply between computers, peripheral devices, and other
computers.
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Acronyms and abbreviations
These acronyms and abbreviations are used in this document.

DK
Development Kit

GPIO
General-Purpose Input/Output

GPS
Global Positioning System

IDE
Integrated Development Environment

IMEI
International Mobile (Station) Equipment Identity

LNA
Low-Noise Amplifier

NFC
Near Field Communication

PIN
Personal Identification Number

PUK
Personal Unblocking Key

SDK
Software Development Kit

SES
SEGGER Embedded Studio

SIM
Subscriber Identity Module

SiP
System in Package

SoC
System on Chip

USB
Universal Serial Bus

UICC
Universal Integrated Circuit Card
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Recommended reading
In addition to the information in this document, you may need to consult other Nordic documents.

• Nordic Thingy:91 Getting Started
• nRF9160 Product Specification
• nRF52840 Product Specification
• nRF9160 DK Hardware
• nRF52840 DK
• nRF9160 Errata
• nRF9160 Revision 2 Errata
• nRF52840 Errata
• nRF Connect SDK documentation
• nRF Cloud (nrfcloud.com)
• nRF Connect LTE Link Monitor
• nRF Connect Programmer
• nRF91 AT Commands Reference Guide
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Legal notices
By using this documentation you agree to our terms and conditions of use. Nordic Semiconductor may
change these terms and conditions at any time without notice.

Liability disclaimer
Nordic Semiconductor ASA reserves the right to make changes without further notice to the product to
improve reliability, function, or design. Nordic Semiconductor ASA does not assume any liability arising out
of the application or use of any product or circuits described herein.

Nordic Semiconductor ASA does not give any representations or warranties, expressed or implied, as to
the accuracy or completeness of such information and shall have no liability for the consequences of use
of such information. If there are any discrepancies, ambiguities or conflicts in Nordic Semiconductor’s
documentation, the Product Specification prevails.

Nordic Semiconductor ASA reserves the right to make corrections, enhancements, and other changes to
this document without notice.

Life support applications
Nordic Semiconductor products are not designed for use in life support appliances, devices, or systems
where malfunction of these products can reasonably be expected to result in personal injury.

Nordic Semiconductor ASA customers using or selling these products for use in such applications do so
at their own risk and agree to fully indemnify Nordic Semiconductor ASA for any damages resulting from
such improper use or sale.

RoHS and REACH statement
Complete hazardous substance reports, material composition reports and latest version of Nordic's REACH
statement can be found on our website www.nordicsemi.com.

Trademarks
All trademarks, service marks, trade names, product names, and logos appearing in this documentation
are the property of their respective owners.

Copyright notice
© 2021 Nordic Semiconductor ASA. All rights are reserved. Reproduction in whole or in part is prohibited
without the prior written permission of the copyright holder.

4418_1336 43

https://www.nordicsemi.com

	Contents
	Revision history
	Introduction
	Kit content
	2.1 Downloadable content

	Hardware description
	3.1 Block diagram
	3.2 Hardware figures
	3.3 nRF9160
	3.3.1 Antenna tuning
	3.3.2 Antenna performance
	3.3.3 RF measurements
	3.3.4 GPS
	3.3.4.1 GPS in Nordic Thingy:91 v1.0.0
	3.3.4.2 GPS in Nordic Thingy:91 v1.4.0

	3.3.5 SIM card

	3.4 nRF52840
	3.4.1 NFC passive tag
	3.4.2 USB

	3.5 Pin maps
	3.6 Motion sensors
	3.7 Environment sensors
	3.8 EEPROM
	3.9 Buzzer
	3.10 LEDs and buttons
	3.10.1 RGB LED
	3.10.2 Buttons

	3.11 Power supply
	3.11.1 PMIC
	3.11.2 Current measurement

	3.12 Programming and debugging interface
	3.13 Interface
	3.13.1 N-MOS transistors
	3.13.2 Connectors
	3.13.2.1 Connector pinouts

	3.13.3 Test points


	Troubleshooting
	4.1 Updating the nRF Cloud certificate
	4.1.1 Downloading the nRF Cloud certificate
	4.1.2 Provisioning the nRF Cloud certificate


	Regulatory notices
	5.1 FCC regulatory notices

	Glossary
	Development Kit (DK)
	International Mobile (Station) Equipment Identity (IMEI)
	GPIO
	Global Positioning System (GPS)
	Integrated Development Environment (IDE)
	Low-Noise Amplifier (LNA)
	MCUboot
	Near Field Communication (NFC)
	nRF Cloud
	Personal Identification Number (PIN)
	Personal Unblocking Key (PUK)
	Software Development Kit (SDK)
	SEGGER Embedded Studio (SES)
	Subscriber Identity Module (SIM)
	System in Package (SiP)
	System on Chip (SoC)
	User Equipment (UE)
	Universal Integrated Circuit Card (UICC)
	Universal Serial Bus (USB)

	Acronyms and abbreviations
	Recommended reading
	Legal notices

